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I 1 INTRODUCTION

To login to BAP using a certificate, you must first prepare a certificate signing request. With this request, a certificate is generated
which must be installed on your computer. Below are instructions on how to generate a certificate signing request on each
operating system, how to download the certificate, install it, and transfer it to another computer.
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I 2 MANAGING CERTIFICATES IN WINDOWS ENVIRONMENT

2.1 Creating a certificate signing request

In Windows environment, there are two ways to do this in the following sections. Choose the one that suits you best and follow the

steps below.

2.1.1 Using the Microsoft Management Console

1. First, prepare a location on your computer where you can later save the certificate request created in the next steps of these
instructions. We recommend that you create a folder named "bapcrt" at Computer - Local Disc (C :). The example below shows
the folder "bapcrt" created in an analogous location at This PC - Windows (C :).

Figure 1 Creating the bapcrt folder

&l M A Manage Windows (C:) - [m] X

Home Share View Drive Tools (2]

€ 5 ~ 4 Ea> ThisPC > Windows (C) v & | SearchWindows (C:) 0

& Downloads # ~  Name Date modified Type Size
) Documeints o4 bapert 2/26/2021 2:07 PM File folder
&) Pictures N

v [ This PC

Vv ie Windows (C:)
bapert

2. To open the Microsoft Management Console, type "mmc" in the Windows Start bar to search for and run the application that you

found.

Figure 2 Search in Windows Start bar

Programs (1)
mmc.exe

S See more results

|mmc | Shut down | » |




CERTIFICATE GENERATION INSTRUCTIONS

BENDRO NAUDOTOJY VALDYMO SISTEMOS, ATITINKANCIOS EUROPOS KOMISIJOS REIKALAVIMUS, SUKORIMO
PASLAUGU PROJEKTAS

Figure 3 Microsoft Management Console window

-
E Consolel - [Console Root]

File Action View Favoritess Window Help

e« B = BE

|| Console Root

Name

There are no items to show in this view.

More Actions 4

n

3. Select File - Add / Remove Snap-in in an opened window. In the pop-up window, select Certificates option.

Figure 4 Certificates section selection

P

Add or Remove Snap-ins l R |

You can select snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For
extensible snap-ins, you can configure which extensions are enabled.

Available snap-ins: Selected snap-ins:
Snap-in Vendor - [ Console Root | EditExtensions... |
' ActiveX Control =
Move Up
2 . = 2 ' Move Down
g=3 Device Manager . |8
=% Disk Management Microsoft and...
{d]Event Viewer Microsoft Cor...
I Folder Microsoft Cor...
'=/ Group Policy Object ... Microsoft Cor...
® 1P Security Monitor  Microsoft Cor...
&, 1p Security Policy M...  Microsoft Cor...
|| Link to Web Address ~ Microsoft Cor... _ [ P ]
- TS §las =3 o~ =
Description:

The Certificates snap-in allows you to browse the contents of the certificate stores for yourself, a service, or a computer.

ok || Ccancel
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4. Click Add> button to the right side of the selection. In the new window, select the My user account option and click the Finish
button at the bottom of the window.

Figure 5 My user account selection

I
Certificates snap-in

i i manage certificates for:
@ My user account

() Service account
() Computer account

\ T - ™7 - T

5. Click OK to close the Snap-in window.
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6. Expand Certificates and find Personal section. Right-click on it to bring up the internal menu. From this menu, select All Tasks -
Advanced Operations > Create custom request.

it
| 7] Console Root Name
| « & Certificates (Local Computer) Y Certificates (Local Computer)
| 4| | Persg=at
B C Find Certificates... l
‘ b Trust[ Al Tasks ’ Find Certificates...
p | Enter
b B Intent New Window from Here Request New Certificate...
p 1 Trust Refresh Import...
b Untiy Help Advanced Operations ’ [ CreatgCustom Request...
E :I 1:::“ Peogile o ManaégEnrollment Policies...
p [ Client Authentication Issuers
p | Remote Desktop
p || Certificate Enrollment Requests

7. Click Next in an opened window. The next window will suggest a strategy for applying the certificate - here you need to select
Proceed without enrollment policy and click Next.

Figure 6 Strategy selection window
-

—al Certificate Enrollment

Select Certificate Enrollment Policy

Certificate enroliment policy enables enroliment for certificates based on predefined certificate templates.
Certificate enrollment policy may already be configured for you.

Configured by you Add New
Custom Request

Proceed without enrollment policy

Learn more about certificate enrollment policy

[ Next ][ Cancel ]




CERTIFICATE GENERATION INSTRUCTIONS
BENDRO NAUDOTOJY VALDYMO SISTEMOS, ATITINKANCIOS EUROPOS KOMISIJOS REIKALAVIMUS, SUKORIMO BAP

PASLAUGU PROJEKTAS

8. In the third window we will be asked to specify a template. Expand the menu and select (No template) Legacy key. Note the
format PKS # 10. After selecting these options, click Next.

Figure 7 Template selection

f o @ %

&) Certificate Enrollment

Custom request

Chose an option from the list below and configure the certificate options as required.

Template: [(No template) Legacy key v
T ] Suppress default extensions

Request format: | @ PKCS #10

© MC

Note: Key archival is not available for certificates based on a custom certificate request, even when this
option is specified in the certificate template.

Learn more about custom request

[ Next ]I[ Cancel
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9. In the certificate information window, expand the details and click the Properties button.

Figure 8 Certificate Information Window

i o 8 %

s Certificate Enrollment

Certificate Information

Click Next to use the options already selected for this template, or click Details to customize the certificate
request, and then click Next.

Custom request 1) STATUS: Available
The following options describe the uses and validity period that apply to this type of certificate:
Key usage:

Application policies:
Validity period (days):

Properties l

Learn more about certificates

[ Next ][ Cancel]
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10. Select the Subject section in an opened window. In the Type field, select Common name and in the Value field, enter your Name
and Surname.

Figure 9 Subject cartilage

d B

Certificate Properties .

General | Subject | Extensions | Private Key |

The subject of a certificate is the user or computer to which the certificate is issued. You
can enter information about the types of subject name and alternative name values that
can be used in a certificate.

Subject of certificate
The user or computer that is receiving the certificate

Subject name:

Type:
[Common name ]
Salue
< Remove
Name Surname
Alternative name:
Type: v
Directory name v
Value: Add >
< Remove

Learn more about subject name

10
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11. When the values are filled in, click the Add> button on the right.

Figure 10 Filling in subject data

Certificate Properties S0 Y |

General | Subject | Extensions | Private Key |
The subject of a certificate is the user or computer to which the certificate is issued. You
can enter information about the types of subject name and alternative name values that
can be used in a certificate.
Subject of certificate
The user or computer that is receiving the certificate

Subject name:

CN=Name Surname

Type: !

[Common name v] Add >

Value: ‘
< Remove

Alternative name:

Type: 1
Directory name v]
Value: Add >

< Remove

Learn more about subject name

ook [ cancel |[ oy ]|}
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12. Fill out Given name and Surname as in previous step, when attributes are present they should show up in the right pane.

Figure 11 Subject rezultatas

Certificate Properties X
General Subject Extensions Private Key
The subject of a certificate is the user or computer to which the certificate is issued. You
can enter information about the types of subject name and alternative name values that
can be used in a certificate.
Subject of certificate
The user or computer that is receiving the certificate
Subject name:
Type: CN=Name Surname
A G=Name
Surname b = SN=Surname
Value:
l < Remove
Alternative name:
Type:
Directory name v
Value:
[ alue Add >
< Remove
OK Cancel Apply

12
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13. In the Alternative name section, fill out your email address.

Figure 12 Alternative name

Certificate Properties

General Subject Extensions Private Key

The subject of a certificate is the user or computer to which the certificate is issued. You
can enter information about the types of subject name and alternative name values that

can be used in a certificate.

Subject of certificate

The user or computer that is receiving the certificate

Subject name:

Type:

Surname v

Value:

|

Alternative name:

Type:

Email

Value:

| email@example.com|

CN=Name Surname

G=Name
Add > SN=Surname
< Remove
Add >
< Remove

T

13
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14. After clicking ,,Add >“ button subject window should show your email address in the right pane.

Figure 13 UZpildytas subject

Certificate Properties

General Subject Extensions Private Key
The subject of a certificate is the user or computer to which the certificate is issued. You
can enter information about the types of subject name and alternative name values that

can be used in a certificate.

Subject of certificate
The user or computer that is receiving the certificate

Subject name: ‘
CN=Name Surname

e
WP Add > G=Name
Surname ~ SN=Surname
Value:
< Remove

|

:Aitemative name:

Type: .
email@example.com

Email v

e

< Remove
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15. Follow the steps in the Private Key section. Expand the Key type area and select the Exchange option.

Figure 14 Key type selection

7

Certificate Properties

| General | subject | Extensions | Private Key

Cryptographic Service Provider v
Key options v
Key type A
L the allowed uses for a private key associated with a certificate.
@ Exchange
() Signature
Key permissions v
Learn more about private key
ok || cancel || Apply
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16. Once you have selected the key type, you need to choose which algorithm is used to encrypt the data. To do this, expand the
Cryptographic Service Providers section and make sure that only one option is selected, Microsoft RSA SChannel Cryptographic
Provider (Encryption).

Figure 15 Choice of encryption algorithm

Certificate Properties &

| General | subject | Extensions | Private Key

>

Cryptographic Service Provider Al

A CSP is a program that generates a public and private key pair used in many
certificate-related processes.

Select cryptographic service provider (CSP):

["] Microsoft DH SChannel Cryptographic Provider (Encryption)
[] Microsoft Enhanced Cryptographic Provider v1.0 (Encryption)

["] Microsoft Enhanced DSS and Diffie-Hellman Cryptographic Provider
(Encryption)

[7] Microsoft Enhanced RSA and AES Cryptographic Provider (Encryption)
Microsoft RSA SChannel Cryptographic Provider (Encryption)

m

1 |

[7] Show all CSPs

Key options v

Key type *
Key usage defines the allowed uses for a private key associated with a certificate.

S = L L

Learn more about private key

Lo [ concd || aepy |
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17. Finally, you need to specify the key size by expanding the Key options section, selecting 2048 next to Key size, and selecting the

Make private key exportable checkbox.

Figure 16 Key size selection

-
Certificate Properties

| General | Subject | Extensions | Private Key

Cryptographic Service Provider

Set the key length and export options for the private key.

Key size: [ 2048 =

Make private key exportable

[] Allow private key to be archived
[ Strong private key protection

Key type
Key usage defines the allowed uses for a private key associated with a certificate.

@ Exchange

() Signature

Key permissions

Learn more about private key

Key options m

m

ook J[ conce ]

Apply
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18. After completing all the above steps, click OK - this will close the pop-up window and return to the wizard. In the wizard, click
Next. You will be asked to specify the disk location where you want to save the certificate request.

Figure 17 Query save dialog
g
= B X4

) Certificate Enrollment

Where do you want to save the offline request?

If you want to save a copy of your certificate request or want to process the request later, save the request
to your hard disk or removable media. Enter the location and name of your certificate request, and then
click Finish.

File Name:

File format:
© Base 64
©) Binary

Learn more about file format

Finish

18
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19. Click the Browse ... button and choose where you want to save the file. It is recommended that you store the file in the "bapcrt”
folder created at the address in step 1. It's important to save a file with a "csr"” extension - to do this, add ".csr” ending to the file
name and specify All files (*. *) option in the Save as type field. Click Save in the dialog box after completing all the steps.

Figure 18 File save dialog

sl Save As X
&« v 4 » ThisPC > Windows (C) bapcrt v O Search bapcrt p

Organize ¥ New folder == v 0

~ Name Date modified Type

B3 This PC
. 3D Objects
Bl Desktop

No items match your search

%) Documents

¥ Downloads

. home (disk)

Jﬁ Music

& Pictures

B videos

‘s Windows (C)
bapcrt

Intel v < >

File namel request.csr

Save as type: All Files (*.*)

A Hide Folders Save Cancel
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20. You will be returned to the wizard where you click Finish. CSR generated successfully and saved to a file you specified. Continue
generating the certificate from the Download and install the certificate section.

Figure 19 End of the wizard

1l 00 aartatiratac
Lyl Certificate Enrollment

Where do you want to save the offline request?

If you want to save a copy of your certificate request or want to process the request later, save the request to
your hard disk or removable media. Enter the location and name of your certificate request, and then click

Finish.

I C\bapcrt\request.csr Browse..

File format:
® Base 64
O Binary

Finish Cancel

2.1.2 Using Command Prompt

1. Create a "request.inf" file. The contents of the file are listed below. Note: You can download the prepared "request.inf" file in the
certificate generation window or on the login page. After downloading the file, enter your first and last name in the Subject line
instead of Name Surname.

Figure 20 Download of the request.inf file for a logged-in BAP user

Generate certificate

Upload generated CSR (Certificate signing request) file.
Certificate Generation Guide

request.int Downloa

CSR file

3

Drag or upload afile

GENERATE CERTIFICATE
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Figure 21 Download the request.inf file for an offline user

The Common User Management Portal is dedicated to persons to access electronic services provided by
the Customs of the Republic of Lithuania and the European Commission.

In order to receive electronic services, you have to be registered as a services recipient and verify your
identity by logging in via the E-Government Gateway or using a digital certificate issued by the Customs.

if you do not have a possibility to verify your identity for registration of services recipient by logging in via the
E-Govemnment Gateway, please submit a Applicag egiciration of services recipient. Following the
Ceriificate Generation Guide and completing the fi ou will take the necessary steps to obtain
Customs digital certificate. It will be used to verify yOUT TOSTITY.

If you fail to login, please contact the Customs IT Services Center by +370 5 236 2302 or email
ITPC@irmuitine.|t.
B e S A e e fP—
TR e ——————
E Registered Certificate fi=sit E-Govemment Gateway

- __./
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[Version]
Signature="$Windows NTS"

[NewRequest]

Subject = "CN=Name Surname, G=Name, SN=Surname"
KeySpec = 1

KeyLength = 2048

Exportable = True

MachineKeySet = False

SMIME = False

PrivateKeyArchive = FALSE

UserProtected = FALSE

UseExistingKeySet = FALSE

ProviderName = "Microsoft RSA SChannel Cryptographic Provider"
ProviderType = 12

RequestType = PKCS10

KeyUsage = 0xal

[Extensions]
2.5.29.17 = "{text}"
_continue = "email=email@example.com"

[EnhancedKeyUsageExtension]
OID=1.3.6.1.5.5.7.3.1

Figure 22 Creating a file request.inf

I M < | bapert

“ Home Share View

&« S5 v > ThisPC > Windows (C:) > bapcrt >

~

Name Date modified Type Size
#* Quick access
ca 2018-05-07 14:35 File folder
&* Dropbox | ] request.csr 2018-05-07 15:12 CSR File 2KB
EJ request.inf 2018-05-07 14:51 Setup Information 1KB

E This PC
‘s Windows (C:)
¥ Network

2. Open the cmd command line. To do this, type "cmd" in the address bar of the current "bapcrt” folder and press the Enter key on

your keyboard.

Figure 23 opening cmd through the address bar

- - -

- .
€ ° I ) T )

cmd
Organize v = - A 0

Search for "cmd”

4 Favorites
Bl Desktop __| request.csr 2021.02.2310:22 CSR File 0KB
& Downloads 4 | request.inf 2021.02.2310:22 Setup Information 0KB
% Recent Places
% Dropbox

- Libraries
E] Documents
J‘ Music
[=) Pictures
B videos
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Figure 24 cmd line window

C:\Windows\system32\cmd.exe - a X

C:\bapcrt>_

3. In the opened window, enter the following command:

C:\bapcrt> certreq -new request.inf request.csr

Figure 25 Example of command entry

C:\Windows\system32\cmd.exe - O X

C:\bapcrt>certreq -new request.inf request.csrg

After successfully creating "request.csr", you will receive a response from the command line:

CertReq: Request Created

23
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Figure 26 Creating a file request.csr

I 4 || = | bapert

“ Home Share View

« = v A > ThisPC > Windows (C:) > bapcrt >

~

Name Date modified Type Size
»#* Quick access
ca 2018-05-07 14:35 File folder
&# Dropbox | ] request.csr 2018-05-07 15:12 CSR File 2KB
[ This PC :_J request.inf 2018-05-07 14:51 Setup Information 1KB

‘s Windows (C:)

¥ Network

2.2 Certificate download and installation

1. If you have not used the BAP system until now and cannot log in via the Electronic Government Gateway, send the prepared
"request.csr" file by e-mail to customs when requested. You will receive a response with "certificate.crt"”, which we will save in
created folder "bapcrt”.

If you can log in to the BAP using the authentication service provided by the Electronic Government Gateway or you have already
used the BAP system and are able to login to it, then attach the file "request.csr" in the Profile section by clicking the Generate new
certificate button. Download the "“certificate.crt" file by clicking the Download button in the modal window or in the certificate data
table. Save the downloaded file to the "bapcrt” folder.

Figure 27 CSR file upload location

Generate certificate

Upload generated CSR (Certificate signing request) file.
Certificate Generation Guide
request.inf Download

CSR file

3

Drag or upload a file

‘GENERATE CERTIFICATE
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Figure 28 CRT file download

Generate certificate
@ Certificate was generated successfully.

Certificate

sertifikatas.cl

Figure 29 Download of a CRT certificate from a certificate data table

Certificate information

GENERATE NEW CERTIFICATE
Owner Issued valid to Status
NAME SURNAME 2021-04-07 2022-04-07 valid (-]
Representative of services recipient RN
Figure 30 Creating the sertifikatas.crt file
&« =5 v A > ThisPC > Windows (C:) > bapcrt >
A
Name . Date modified Type Size
s Quick access
ca 2018-05-07 14:35 File folder
&# Dropbox [ ] request.csr 2018-05-07 15:12 CSR File 2KB
3 This PC & request.inf 2018-05-07 14:51 Setup Information 1KB
— 5 sertifikatas.crt 2018-05-07 15:16 Security Certificate 2KB

‘s Windows (C:)

¥ Network

2. Import the certificate into the user certificate cache. Right-click on the "sertifikatas.crt" file and select Install Certificate in the
pop-up window that opens.

Figure 31 Importing a certificate into the user certificate cache

&« =5 v A > ThisPC > Windows (C:) » bapcrt >

~

Name Date modified Type Size
s Quick access .
ca 2018-05-07 14:35 File folder
> ms . - .
&* Dropbox | ] request.csr 2018-05-07 15:12 CSR File 21
{:J request.inf 2018-05-07 14:51 Setup Information 11

] sertifikatas.crt

‘s Windows (C:)

| Install Certificate I

7-Zip >

¥ Network
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Figure 32 Certificate Import Wizard: placement location selection

&# Certificate Import Wizard

Welcome to the Certificate Import Wizard

This wizard helps you copy certificates, certificate trust lists, and certificate revocation
lists from your disk to a certificate store.

A certificate, which is issued by a certification authority, is a confirmation of your identity
and contains information used to protect data or to establish secure network
connections. A certificate store is the system area where certificates are kept.

Store Location
(® Current User
(O Local Machine

To continue, dick Next.
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Figure 33 Certificate Import Wizard: specifying the location

€& &# Certificate Import Wizard

Certificate Store

Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate store, or you can specify a location for
the certificate.

(® Automatically select the certificate store based on the type of certificate
(O Place all certificates in the following store

Browse...

Cancel
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Figure 34 Certificate Import Wizard: Reviewing settings

€& &# Certificate Import Wizard

Completing the Certificate Import Wizard

The certificate will be imported after you dick Finish.

You have specified the following settings:

[0 g il e Saied Automatically determined by the wizard

Content Certificate

Cancel

Figure 35 Certificate Import Wizard: notification of the successful completion of a certificate import

Certificate Import Wizard X

0 The import was successful.
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2.3 Preparing the certificate to work on another computer

1. To open the Microsoft Management Console, type "mmc" in the search field in the Windows Start bar and start the application
that you found.

Figure 36 Search in the Windows Start bar

Programs (1)

& mmc.exe

S See more results
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Figure 37 Microsoft Management Console window

-
E Consolel - [Console Root]

File Action View Favoritess Window Help

e« B = BE

|| Console Root

Name

There are no items to show in this view.

More Actions 4

n

2. Select File > Add / Remove Snap-in in an opened window. In the popup window, select Certificates option.

Figure 38 Certificates section selection

P

Add or Remove Snap-ins l R |

You can select snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For
extensible snap-ins, you can configure which extensions are enabled.

Available snap-ins: Selected snap-ins:
Snap-in Vendor - [ Console Root | EditExtensions... |
' ActiveX Control =
Move Up
2 . = 2 ' Move Down
g=3 Device Manager . |8
=% Disk Management Microsoft and...
{d]Event Viewer Microsoft Cor...
I Folder Microsoft Cor...
'=/ Group Policy Object ... Microsoft Cor...
® 1P Security Monitor  Microsoft Cor...
&, 1p Security Policy M...  Microsoft Cor...
|| Link to Web Address ~ Microsoft Cor... _ [ P ]
- TS §las =3 o~ =
Description:

The Certificates snap-in allows you to browse the contents of the certificate stores for yourself, a service, or a computer.

ok || Ccancel
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3. Click Add> button to the right side of the selection. In the new window, select the My user account option and click the Finish
button at the bottom of the window.

Figure 39 My user account selection

I
Certificates snap-in XS

i i manage certificates for:
@ My user account

) Service account
() Computer account

\

4. Click Finish to close the Snap-in window.
You should see the imported certificate in an opened window.

Figure 40 View the imported certificate

certmgr - [Certificates - Current User\Personal\Certificates]
File Action View Help
e 2@ BRI XEEHE

GV Certificates - Current User lssued To
v [ Personal

| Certificates
> [ Trusted Root Certification Au
> [ Enterprise Trust
> ] Intermediate Certification Au
> [ Active Directory User Object
> [ Trusted Publishers
> [ ] Untrusted Certificates
> [ Third-Party Root Certificatior
> [ Trusted People
>
>
>
>
>

Issued By Expiration Date  Intended Purposes Friendly Name Status  Certificate Te...
£ Name Surname 2028-05-04

] Client Authentication Issuers
| Other People

] Local NonRemovable Certific
1 Certificate Enroliment Reque:

| Smart Card Trusted Roots

< >

Personal store contains 1 certificate.
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5. Verify that the certificate has the appropriate private key. After double-clicking on the certificate, you should see the message
You have a private key that corresponds to this certificate.

Figure 41 Certificate private key verification

o Certificate X

General Details Certification Path

fi a Certificate Information

Windows does not have enough information to verify
this certificate.

Issued to: Name Surname

Issued by: BAPCA

valid from 2018-05-07 to 2028-05-04

? You have a private key that corresponds to this certificate.

Issuer Statement

[oc ]

6. Export the certificate along with the private key to a file for use on other computers and to have a backup:

Figure 42 Certificate Export

certmgr - [Certificates - Current User\Personal\Certificates] = [m] X
File Action View Help
e | 2@ 4B XEE Hm

¥ Certificates - Current User lssued To

] Client Authentication Issuers Help
[ Other People

“| Local NonRemovable Certific

“| Certificate Enrollment Reque:

Issued By Expiration Date  Intended Purposes Friendly Name Status  Certificate Te...
v [ Personal 5% Name Surname Beacs 2028-05-04 <All>
| Certificates Open
> [ Trusted Root Certification Au!
> [ Enterprise Trust All Tasks > Open
> ﬂ Intermediate Certification Au; Cut Request Certificate with New Key.s
> [ Active Directory User Object = 2
s (B Trusted Publishers Copy Renew Certificate with New Key...
> [ Untrusted Certificates Delete Advanced Operations >
> [ Third-Party Root Certificatior| P =
- roperties
> [ Trusted People i Export...
>
>
>
>
>

“| Smart Card Trusted Roots

< >

Export a certificate
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Figure 43 Certificate Export Wizard

“# Certificate Export Wizard

Welcome to the Certificate Export Wizard

This wizard helps you copy certificates, certificate trust lists and certificate revocation
lists from a certificate store to your disk.

A certificate, which is issued by a certification authority, is a confirmation of your identity
and contains information used to protect data or to establish secure network
connections. A certificate store is the system area where certificates are kept.

To continue, dick Next.

Cancel
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Figure 44 Certificate Export Wizard: Format selection

& &# Certificate Export Wizard

Export File Format
Certificates can be exported in a variety of file formats.

Select the format you want to use:
DER encoded binary X.509 (.CER)
Base-64 encoded X.509 (.CER)

Cryptographic Message Syntax Standard - PKCS #7 Certificates (.P78)

Indude all certificates in the certification path if possible

(® Personal Information Exchange - PKCS #12 (.PFX)
[M indude all certificates in the certification path if possible

[[Jpelete the private key if the export is successful
[CJexport all extended properties
[MEnable certificate privacy

Microsoft Serialized Certificate Store (.SST)

" Concel
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7. Select to export the private key together with the certificate.

Figure 45 Certificate Export Wizard: Exporting a private key

& &# Certificate Export Wizard

Export Private Key
You can choose to export the private key with the certificate.

Private keys are password protected. If you want to export the private key with the
certificate, you must type a password on a later page.

Do you want to export the private key with the certificate?

(@ Yes, export the private key

(O No, do not export the private key
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8. Create a password that will protect the private key of the certificate.

Figure 46 Certificate Export Wizard: Creating a password

& &* Certificate Export Wizard

Security
To maintain security, you must protect the private key to a security principal or by
using a password.

[[] Group or user names (recommended)

Add

Remove

[ Password:

I........ I

Confirm password:

|........| I

Clicking Next will take you to a window where you will need to specify the export location and file name.
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Figure 47 Certificate Export Wizard: Creating file name

\ “* Certificate Export Wizard

File to Export
Specify the name of the file you want to export

File name:
C:\bapcrt\sertifikatas.pfy Browse...

Next Cancel

Clicking Next will open a window for reviewing the settings and completing the export operation. After viewing the information,
click Finish.
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Figure 48 Certificate Export Wizard: Settings review

2 “* Certificate Export Wizard

Completing the Certificate Export Wizard

You have successfully completed the Certificate Export wizard.

You have specified the following settings:

After completing this step, you will be notified of the successful completion of the export.

Figure 49 Certificate Export Wizard: Notification of the successful completion of a certificate export

Certificate Export Wizard X

The export was successful.

File Name C:\bapcrt\sertifikatas.pfx

Export Keys Yes

Include all certificates in the certification path  Yes

File Format Personal Information Exchange (*.pfx’

< >
Finish Cancel
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9. The resulting "sertifikatas.pfx" file contains your certificate and its private key. You can easily import it to another computer.
Figure 50 Display of the exported sertifikatas.pfx file

| M + | bapert

Home Share View
o v 4 > ThisPC > Windows (C:) > bapcrt >
Name Date modified Type Size
v 3k Quick access
j D ; " ca 201 File folder
%) Documents = :
| ] request.csr 201 CSR File 2KB
= Pi * v . :
B Eechues 4| request.inf 2018-05-07 Setup Information 1KB
* Downloads * ] sertifikatas.crt 2018-05-07 Security Certificate 2KB
I Desktop #  [3) sertifikatas.pfx 2018-05-07 Personal Informati... 3KB
. storage *

> &% Dropbox
> 3 This PC
> am Windows (C:)

» £ Network
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I 3 CERTIFICATE MANAGEMENT IN MACOS ENVIRONMENT

3.1 Creating a certificate signing request
If you are using macOS , you can generate a certificate request using the "openss/” command via a terminal.
1. For your convenience, we recommend that you create a new folder (such as "bapcrt") on your desktop.

Figure 51 Folder creation

@ Finder File Edt View Go Window Help

Get Info

Change Desktop Background...
Sort By »
Show View Options

@ Finder File Edit View Go Window Help
P ——— e

2. Launch the Terminal application. You can use the search by clicking Command-Space bar and typing "terminal" in the search
field:

Q  terminal [k}

Terminal

Kind  Appication
Size 98WV8
Created OVON20Y7
Modified 3N2/2020
Term Last opened  20,0V20

or by selecting Go -> Utilities in the Finder menu
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@ Finder File Edt View I window Hebp

Select Startup Disk  OX?T

8 Recents OXF
® Documents o%X0
@ Desktop OXD
© Downloads %L
bapert @ Home ORH
2 Computer oXC
® AirOrop OXR
@ Network O%XK
& iCloud Drive o
#x Appiications ORA
| Xutites  OXU |
Go to Folder... OXG

Connect to Server.. xK

AWt

R o T
m&.@ -t
ec e

w (nires
a m-o-) ¢
ATty Mot Ad e AR Adte AR Arte Adote Crestwe Adte rotatery
Aghcat  ratater Unnstater Ao e Consd Lagrience
/ \ -
@ M o 2 X
-
Y = s
Adobe Unites - ArPort Usiey Ausio VOH Setp Descon fie Boot Cavo ColorSync Uniiey
cse Cacrange Asaaiace
- @ g p’ ‘ U
Cirniie Ongta Comoa Oisk Uiy ot Oraphar Laychan Aicess
Veter
A A -«
' o . KN
Vo Scret tarer Syve= VoiceOver Utiity
Assatant oo

3. In the terminal go to the created folder "bapcrt" by entering the command (press the Enter key to execute the command)

' cd Desktop/bapcrt |

4. Generate a certificate request using the "openss|" command:

openssl req -out request.csr -utf8 -new -newkey rsa:2048 -nodes -keyout certificate.key \
i -subj "/GN=Vardas/SN=Pavarde/CN=Vardas Pavarde" \
-regexts SAN \
-config <(cat /etc/ssl/openssl.cnf \
<(printf "\n[SAN]\nsubjectAltName=email:el.pastas@pastas.lt"))

Country Name (2 letter code) [AU]:LT

State or Province Name (full name) [Some-State]:n/a

Locality Name (eg, city) []:n/a

Organization Name (eg, company) [Internet Widgits Pty Ltd]:n/a
Organizational Unit Name (eg, section) []:

Common Name (e.g. server FQDN or YOUR name) []:Name Surname
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Figure 52 Certificate request generation

[&] (€] bapcrt — -bash — 109x20

You are about to be asked to enter information that will be incorporated
into your certificate request.

wWhat you are about to enter is what is called a Distinguished Name or a DN.
There are quite a few fields but you can leave some blank

For some fields there will be a default value,

If you enter '.', the field will be left blank.

Country Name (2 letter code) [J):LT

State or Province Name (full name) [):

Locality Name (eg, city) []):

Organization Name (eg, company) []):

Organizational Unit Name (eg, section) (]):

Common Name (eg, fully qualified host name) []):Name Surname

Email Address []:

Please enter the following ‘extra' attributes
to be sent with your certificate request

A challenge password [):

IN-iMac:bapcrt Jonas$ J}

5. Check available files:

IN-iMac:bapcrt Jonas$ Is -I

total 16

-rw-r--r-- 1 Jonas staff 1704 Sau 29 21:29 certificate.key
-rw-r--r-- 1 Jonas staff 915 Sau 29 21:29 request.csr

3.2 Certificate download and installation

1. If you have not used the BAP system until now and cannot log in via the Electronic Government Gateway, send the prepared
"request.csr" file by e-mail to customs when requested. You will receive a response with “certificate.crt”, which we save in the
"bapcrt" folder.

If you can log in to the BAP using the authentication service provided by the Electronic Government Gateway or you have used the
BAP system before and can log in to it, attach the file "request.csr" in the Profile section by clicking the Generate new certificate
button. Download the “certificate.crt" file by clicking the Download button in the modal window or in the certificate data table.
Move the downloaded file to the "bapcrt” folder.

Figure 53 CSR file upload location

Generate certificate

Upload generated CSR (Certificate signing request) file.
Certificate Generation Guide
request.inf Download

CSR file

3

Drag or upload a file

‘GENERATE CERTIFICATE
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Figure 54 CRT file download

Generate certificate
@ Certificate was generated successfully.

Certificate

sertifikatas.cl

Figure 55 Download of a CRT certificate from a certificate data table

Certificate information

GENERATE NEW CERTIFICATE
Owner Issued valid to Status
NAME SURNAME 2021-04-07 2022-04-07 Walid [+ ]
—

Representative of services recipient

JN-iMac:bapcrt Jonas$ 1ls -1

total 12

-rw-r--r-- 1 Jonas staff 1704 Sau 29 21:29 certificate.key
-rw-r--r-- 1 Jonas staff 915 Sau 29 21:29 request.csr
-rw-r--r-- 1 Jonas staff 915 Sau 29 21:29 sertifikatas.crt

openssl pkcsl2 -export -out sertifikatas.pfx -inkey certificate.key -in
sertifikatas.crt

43



CERTIFICATE GENERATION INSTRUCTIONS
BENDRO NAUDOTOJY VALDYMO SISTEMOS, ATITINKANCIOS EUROPOS KOMISIJOS REIKALAVIMUS, SUKORIMO
PASLAUGU PROJEKTAS

Figure 56 Example of export

[] ® bapcrt — -bash — 93x20

IN-iMac:bapcrt Jonas$ 1s -1

total 24

~rw-r--r-- 1 Jonas staff 1704 Sau 29 21:29 certificate.key

~rw-r--y-- 1 Jonas staff 915 Sau 29 21:29 request.csr

-rw-r--r--@ 1 Jonas staff 1985 Sou 29 21:45 sertifikatas.crt

IN-iMac:bapcrt Jonas$ openssl pkcsi2 ~export -out sertifikatas.pfx -inkey certificate.key =-in
sertifikatas.crt

Enter Export Password:

Verifying - Enter Export Password:

IN-iMac:bapcrt Jonas$ J§

Check what files you have:

JN-iMac:bapcrt Jonas$ 1ls -1

total 12

-rw-r--r-- 1 Jonas staff 1704 Sau 29 21:29 certificate.key
-rw-r--r-- 1 Jonas staff 915 Sau 29 21:29 request.csr
-rw-r--r-- 1 Jonas staff 915 Sau 29 21:29 sertifikatas.crt
-rw-r--r-— 1 Jonas staff 915 Sau 29 21:29 sertifikatas.pfx

sertifikatas.pfx - file what will have your public and private key inside.

3. Certificate import in macOS .

44



CERTIFICATE GENERATION INSTRUCTIONS
BENDRO NAUDOTOJY VALDYMO SISTEMOS, ATITINKANCIOS EUROPOS KOMISIJOS REIKALAVIMUS, SUKORIMO
PASLAUGU PROJEKTAS

Figure 57 To import a certificate from the Finder, select Go -> Utilities and start the Keychain Access application

o0 e 0 Utilities
B oo sy % o = 0 P . »
Back/Forward View Arrange Action Share Edit Tags Path  Getinfo New Folder Delete Eject
Utilities ES
Favorites Name ~  Date Modified Date Created
@ Pictures » 11 Adobe Application Manager 2019-02-03 13:14 2018-08-12(
» 1 Adobe Creative Cloud Experience 2019-01-24 12:20 2019-01-24
£33 virtual Machines » 11 Adobe Installers 2019-02-03 13:07 2017-04-06
© Downloads > I Pagalbinés Adobe programos - CS6  2019-01-31 20:12 2019-01-31 3
Q AirDrop I Activity Monitor.app 2020-12-31 08:51 2017-08-03 (
) Adobe AIR Application Installer.app 2019-02-03 13:20 2019-02-03
£ Google Drive B8 Adobe AIR Uninstaller.app 2019-02-03 13:20 2019-02-03
) Desktop @ AirPort Utility.app 2020-12-31 08:51 2017-07-16 ¢
G] Jonss M Audio MIDI Setup.app 2020-12-31 08:51 2017-07-17 ¢
< Bluetooth File Exchange.app 2020-12-31 08:51 2017-09-28 (
Recents Z Boot Camp Assistant.app 2020-12-31 08:51 2017-08-19 ¢
& iCloud Drive X ColorSync Utility.app 2020-12-31 08:51 2017-07-18 ¢
[3 B e @ Console.app 2020-12-31 08:51 2017-07-16 ¢
@ Digital Color Meter.app 2020-12-31 08:51 2017-07-19(
J7 Music & Disk Utility.app 2020-12-31 08:51 2017-10-11
£ Creative Cloud Files ¥ Grab.app 2020-12-31 08:51 2017-07-16 (
. » Grapher.app 2020-12-31 08:51 2017-07-27
A pplicat » Keychain Access.app -12-31 08:51
Devices & Migration Assistant.app 2020-12-31 08:51 2017-07-16 ¢
[ = NI | Script Editor.app 2020-12-31 08:51 2017-07-16
v JiN"iviac A -
« System Information.app 2020-12-31 08:51 2017-07-15
© Remote Disc B Terminal.app 2020-12-31 08:51 2017-08-01
@ VoiceOver Utility.app 2020-12-31 08:51 2017-10-12
Tags
@® Red
© Orange
e & Macintosh HD > I Applications > I Utilities > A Keychain Access.app
X 1 of 23 selected, 147,02 GB available
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Figure 58 On the left side of the Keychain Access application, select System
@ Keychain Access File Edit View Window Help
[ N Keychain Access

a Click to unlock the System keychain.

Keychains
com.apple.kerberos.kdc

) Self-signed root certificate
iCloud - Expires: 2036 m. lapkri€io 29 d., Sedtadienis 11:39:24 Ryty Europos Ziemos laikas
4 This certificate has not been verified by a third party

» login Cortificerte

. System Roots
Name ~ Kind Expires Keychain
L com.apple.kerberos.kdc certificate 2036-11-29 11:39:24 System
] com.apple.systemdefault certificate 2036-11-29 11:39:23 System
23 http://openvp...html #1571467008 certificate 2029-10-16 09:36:48 System

Category
A All ltems
L. Passwords
Secure Notes
& My Certificates
| Keys
] certificates

Figure 59 From the File menu, select Import Items...

@& Keychain Access I Edit View Window Help

'R New Password Item... BN 1 Access
. New Secure Note Item... O®N ,
- Click to unlock the Syst  New Keychain... X ¥N l Q
New Certificate Preference...
Keychains
s login Import Items... oxXl
iCloud g dienis 11:39:24 Ryty Europos iemos laikas
2 d by a third party
Add Keychain... ORA
[T System Roots " 2
Nar Expires Keychain
| Close XW e 2036-11-29 11:39:24 System
| te 2036-11-29 11:39:23 System
| Get Info ) te 2029-10-16 09:36:48 System
Unlock Keychain "System* ®L
Lock All Keychains
Category
A Al tems
L. Passwords
Secure Notes
L My Certificates
| Keys
I O cenificates
l @ +N i 3items I
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Figure 60 Select the generated certificate

@ Keychain Access File Edit View Window Help

~
@ Keychain Access
u Click to uniock the System keychain
Keycha pr— — 3 -~ 1 N
L < s Bo =@ bapert & O O Q
u login
iCloud Favorites Name ~  Date Modified Size Kind
L System [ Recents
0 System -
= 8 Pi
.- . sertifikatas.crt Siandien 17:23 2KB certificate
] Virtual Machines B sertifikatas.pfx Siandien 17:24
© Downloads
) Google Drive
) Desktop
£z} Jonas
Categc () iCloud Drive
A Alltemt & pocuments
L. Passwor .
Securel “¢ Music
(G MyCert ) Creative Cloud...
I Keys 7 Applications
J Certifict
Devices
Options Cancel
@ + M i 3items ]

After selecting the certificate, the system will ask you to enter the administrator password, followed by the password of the
generated certificate that was created in step 2.

~ Enter the password for “sertifikatas.pfx":

l—g Password: eeeecccee

cancel (TN

When the certificate is imported after starting the new Safari browser, it will be possible to log in to bap.Irmuitine.lt after selecting
the certificate. When connecting for the first time, the MacOS system will ask for the administrator name and password again.
Entering them will connect to the system.

3.3 Preparing the certificate to work on another computer

To work on another computer, you need the pfx file that was generated in step 2 of the Download and install the certificate.
Transfer this file to a new computer and continue with the steps in the installation instructions below.
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I 4 CERTIFICATE MANAGEMENT IN LINUX ENVIRONMENT

4.1 Creating a certificate signing request

If you are using Linux, you can generate a certificate request using the "openss/" command via a terminal.

1. First, prepare a location on your computer where you will later save the certificate request created in the next steps of the
manual, for which we recommend creating the "bapcrt" folder. Navigate to this folder and generate a certificate request
using the "openss|" command:

1linux@PC$ openssl reqg -out request.csr -utf8 -new -newkey rsa:2048 -nodes -keyout certificate.key \
-subj "/GN=Name/SN=Surname/CN=Name Surname" \
-regexts SAN \
-config <(cat /etc/ssl/openssl.cnf \
<(printf "\n[SAN]\nsubjectAltName=email:emaill@example.com"))

"Country Name" = LT

Country Name (2 letter code) [AU]:LT

State or Province Name (full name) [Some-State]:n/a

Locality Name (eg, city) []:n/a

Organization Name (eg, company) [Internet Widgits Pty Ltd]:n/a
Organizational Unit Name (eg, section) []:

Common Name (e.g. server FQDN or YOUR name) []:Name Surname

Example:

1inux@PC$ openssl req -out request.csr -new -newkey rsa:2048 -nodes -keyout
certificate.key
Generating a 2048 bit RSA private key

writing new private key to 'certificate.key'

You are about to be asked to enter information that will be incorporated
into your certificate request.

What you are about to enter is what is called a Distinguished Name or a DN.
There are quite a few fields but you can leave some blank

For some fields there will be a default value,

If you enter '.', the field will be left blank.

Country Name (2 letter code) [AU]:LT

State or Province Name (full name) [Some-State]:n/a

Locality Name (eg, city) []:n/a

Organization Name (eg, company) [Internet Widgits Pty Ltd]:n/a
Organizational Unit Name (eg, section) []:

Common Name (e.g. server FQDN or YOUR name) []:Name Surname

Email Address []:

Please enter the following 'extra' attributes

to be sent with your certificate request

A challenge password []:

An optional company name []:

linux@PC$ 1ls -1

total 8

-rwXrwxrwx 1 root root 1704 May 7 15:37 certificate.key
-rwxrwxrwx 1 root root 980 May 7 15:37 request.csr
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4.2 Sertifikato atsisiuntimas ir diegimas Certificate download and installation

1. If you have not used the BAP system until now and cannot log in via the Electronic Government Gateway, send the prepared
"request.csr" file by e-mail to customs when requested. You will receive a response with “certificate.crt”, which we save in the
"bapcrt” folder.

If you can log in to the BAP using the authentication service provided by the Electronic Government Gateway or you have used the
BAP system before and can log in to it, attach the file "request.csr" in the Profile section by clicking the Generate new certificate
button. Download the “certificate.crt" file by clicking the Download button in the modal window or in the certificate data table.
Save the downloaded file to the "bapcrt” folder.

Figure 61 CSR file upload location

Generate certificate

Upload generated CSR (Certificate signing requesi) file.
Certificaie Generation Guide
request.inf Download

CSR file

3

Drag or upload a file

‘GENERATE CERTIFICATE

Figure 62 CRT file download

Generate certificate
@ Certificate was generated successfully.

Certificate

sertifikatas.c

Figure 63 Download of a CRT certificate from a certificate data table

Certificate information

GENERATE NEW CERTIFICATE
Owner Issued valid to Status
NAME SURNAME 2021-04-07 2022-04-07 valid [ - ]

Representative of services recipient
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1inux(@PCS$$
total 12

—TWXTWXYWX
“TWXTWXYWX
—IrWXIWXIrWX

linux@PC$:/mnt/d/bapcrt/linux$ openssl pkcsl2 -export -out sertifikatas.pfx

1 root root 1704 May
1 root root 980 May
1 root root 1127 May

7 15:37 certificate.key
7 15:37 request.csr
7 15:41 sertifikatas.crt

certificate.key -in sertifikatas.crt
Enter Export Password:
Verifying - Enter Export Password:

linux@PCS$:/mnt/d/bapcrt/linux$ 1ls -1

total 16

—“TWXTWXYWX
“TWXTWXYWX
—IrWXIWXIrWX
—IrWXIWXIrWX

i

root
root
root
root

root 1704 May
root 980 May
root 1127 May
root 2389 May

~ J 3

15:
15:
15:
15:

37
37
41
43

certificate.key
request.csr
sertifikatas.crt
sertifikatas.pfx

sertifikatas.pfx - file what will have your public and private key inside.

3. Importing a certificate for use on a linux system is configured in the browser. Open your browser settings, locate the Privacy &

Security section, select Certificates option and click View Certificates

Figure 64 View Certificates section

ﬁ' General
0 Home
Q Search

a Privacy & Security

I
K/ Sync

@ Your browser is being managed by your organization.

Privacy Notice

d in Options

Allow Firefox to send technical and interaction data to Mozilla Learn more

Allow Firefox to make persona

zed extension recommendations

Allow Firefox to install and run studies View Firefox studies

Allow Firefox to send backlogged crash reports on your behalf

Security

Deceptive Content and Dangerous Software Protection

Block dangerous and deceptive content Learn more

Block dangerous downloads

Warn you about unwanted and uncommon software

Certificates

Query OCSP responder servers to confirm the current validity of

certificates

Learn more

Learn more

View Certificates...

Security Devices...
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4. In an opened window in the Your Certificates section, click Import, specify your pfx file and the password you specified in step 3.

Figure 65 Certificate installation window

Certificate Manager X
Your Certificates Authentication Decisions People Servers Authorities
You have certificates from these organizations that identify you
Certificate Name Security Device Serial Number Expires .. |B

> MD BAP
> Sectigo Limited

©
M
o
~
m

View... Backup... Backup All... Import...
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5. After the certificate is successfully uploaded, you will see it in the list.

Figure 66 List of certificates

Certificate Manager

Your Certificates Authentication Decisions People Servers Authorities

You have certificates from these organizations that identify you

bt

Certificate Name Security Device Serial Number Expires On

Vv MD BAP
Name Surname Software Security Devi... 00:85:D4:15:64:56:5C:2... Friday, April 8, 2022

Backup All... Import...

4.3 Preparing the certificate to work on another computer

To work on another computer, you need the pfx file that was generated in step 2 of the Download and install the certificate section.

Transfer this file to a new computer and continue with the steps in the installation instructions below.
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